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Handleiding RefWorks Legacy met WNC4

1.1.INLEIDING

RefWorks is bibliografische software waarmee je een persoonlijke databank met bibliografische gegevens
op kan bouwen.

Met RefWorks kun je:
1.Een literatuurdatabase aanmaken, waarin literatuurverwijzingen uit databases worden geimporteerd.
2.Literatuurverwijzingen beheren: voorzien van trefwoorden, ordenen in mappen, ontdubbelen,
doorzoeken.
3.Literatuurverwijzingen delen met anderen. Zo kunnen docenten een map delen als
leeslijst voor een cursus, studenten een literatuurlijst beschikbaar stellen aan een
begeleidend docent, en kunnen onderzoekers of studenten onderling samenwerken met
gedeelde mappen of zelfs gedeelde RefWorks accounts.
4 Literatuur citeren en opnemen in een document in Word.
5.Een literatuurlijst genereren in een stijl naar keuze (bijv APA, MLA, Harvard).

1.2. REGISTREREN EN ACCOUNT AANMAKEN

Je moet zelf éénmalig een account aanmaken op www.refworks.com/refworks2/
Open de Site en klik op Login.
Kies voor :Sign Up for a New Account:

Login using RefWorks Credentials

Username
Password

Forgot username or password?

Keep my session open for 14 days

Login using Other Credentials

Open Athens Credentials

My Institution's Credentials (Shibboleth) + /
New to RefWorks?Sign Up for a New Account
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Dat levert het volgende scherm op (let op eventuele pop-up blokkering):

Create Account X

Step 1 Step 2 Finished =
Account Information User Information Enjoy RefWorks!

Create an account through your institution, or create a 30 day frial:

I'wantto create a 30 day trial. (Mot associated with institution).
® | have a Group Gode: -4, Find Institution

Subscriber access code given by your RefiWorks adminisirator.

Email Address: | |

Re-enter Email ‘
Address:

Login Name: | |

Password: | |

Re-enter Password | |

= HNext

Gebruik als Group Code RWHUtrecht en vul de verdere gegevens in.
Gebruik je HU-e-mailadres.

Het wachtwoord is vast en wijzigt niet mee als je je HU account-wachtwoord verandert.

Dus beheer je wachtwoord goed.
Je kunt per e-mailadres meerdere accounts aanmaken, bijv. een apart account voor groepswerk.

Een volgende keer log je in met het aangemaakte account.

C
Login using RefWorks Credentials
Username
«——
Password
«—

Show

Forgot username or password?

Keep my session open for 14 days

Login using Other Credentials

Open Athens Credentials
My Institution's Credentials (Shibboleth) +

New to RefWorks?Sign Up for a New Account
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1.3. HET VERZAMELEN VAN LITERATUURVERWIJZINGEN

De verschillende manieren waarop literatuurverwijzingen aan je RefWorks account toegevoegd
kunnen worden zijn:

1. Direct export
Veel databanken bieden de mogelijkheid om direct literatuurverwijzingen te exporteren
naar RefWorks, zoals Academic Search Pemier, Science Direct, Web of Science.
2. Importeren
Sommige databanken die geen Direct Export optie hebben, bieden de mogelijkheid om tekst
bestanden met daarin de gewenste literatuurverwijzingen te importeren (Picarta).
3 Handmatig invoeren
Soms kun je bepaalde literatuurverwijzingen alleen handmatig invoeren.

ledere geimporteerde literatuurverwijzing wordt door RefWorks voorzien van een uniek
nummer (Ref ID). Als je bij het importeren geen map kiest waarin je de te importeren
verwijzingen wilt plaatsen, dan worden ze door RefWorks in de map Last imported folder
geplaatst. Van daaruit kan je ze achteraf nog verplaatsen naar een andere map.

1.4. LITERATUURVERWIJZINGEN BEHEREN EN ORGANISEREN

Literatuurverwijzingen kun je beter beheren en ordenen door mappen aan te maken.

Klik op New folder om nieuwe folders aan te maken.

Klik op Organize and Share Folders om alle folders te zien en bekijk de opties. Hierin kun je o.a.
referenties verwijderen, ontdubbelen en verplaatsen en ook literatuurverwijzingen met anderen delen.

Meer over literatuurverwijzingen beheren:

Klik op Tutorials onder HELP > Tutorial in de menubalk van

RefWorks:

De literatuurverwijzingen kunnen onder meer gesorteerd worden op eerste auteur, jaar van
publicatie, etc.

1.5. HET VERWIIJDEREN VAN DUBBELE LITERATUURVERWIJZINGEN

Als literatuurverwijzingen vanuit verschillende informatiebronnen geimporteerd worden, dan
kan het voorkomen dat artikelen meerdere keren in RefWorks voorkomen.

Het opsporen van dubbele literatuurverwijzingen in RefWorks gaat als volgt:

Klik op het tabblad Organize and Share Folder.

Kies voor View> Duplicates.

Bij Exact Duplicates wordt gezocht naar literatuurverwijzingen die exact hetzelfde zijn op
basis van de auteursnamen, de titel en het jaar van publicatie. Bij Close Duplicates zijn deze
velden niet exact hetzelfde.

RefWorks vinkt al automatisch een van de dubbele literatuurverwijzingen aan.

Als je het eens bent met deze selectie klik dan op ‘Delete’.

NB. De verwijderde literatuurverwijzingen worden 30 dagen bewaard in een folder onder View>Deleted
References. Terugplaatsen naar je RefWorks database is mogelijk via deze folder. Vink de titels aan en

klik op > (= restore).
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1.6 REFERENTIES WIJZIGEN

Je kunt zelf referenties wijzigen. Als je het artikel hebt in de vorm van een pdf-bestand kun je deze ook
als attachment aan de referentie toevoegen.

Kies naast de referentie die je wilt aanpassen het schrijficoontje “Edit”. Je kunt nu alle velden die je wilt
wijzigen.

Indien je een bestand wilt toevoegen klik je naast “Attachments” op ‘Browse’. Zoek het juiste bestand op
je schijf en klik op ‘Openen’. Het bestand wordt nu toegevoegd.

Klik op “Save Reference”. Indien je een attachment hebt toegevoegd zie je nu het icoon van een
paperclipje naast je referentie staan.

1.7 REFERENTIES ZELF INVOEREN

Op deze manier kun je zelf boeken, websites, dvd’s, proefschriften etc. beschrijven. Elk Ref Type heeft
specifieke invulvelden.

Klik in het menu op ‘New Reference’

Ga je een boek invoeren; zet “Ref Type” op “Book, Whole”

Vul bij “Authors”de auteursnaam in en klik vervolgens op het volgende veld: “Book Title”

Vul bij “Book Title” de titel in.

Vul bij “Pub Year” het jaartal in.

De overige velden kunnen naar believen worden ingevuld of open gelaten

Helemaal onderaan zijn er nog extra velden, zoals User 1, User 2... voor eigen kwalificaties en
aantekeningen

Klik onderin het scherm op ‘Save Reference’.

1.8. ATTACHMENTS TOEVOEGEN AAN LITERATUURVERWIJZINGEN

Aan literatuurverwijzingen kunnen bestanden toegevoegd worden. Dit kan een pdf-bestand zijn
van het artikel, maar bijvoorbeeld ook een Worddocument, een Exceldocument,
een PowerPoint presentatie, een afbeelding, etc.

Het toevoegen van een bestand aan een referentie gaat als volgt:
Klik op Edit ' rechts in de balk naast de referentie (Standard/Full View).

Klik op Browse (achter Attachments) en zoek het bestand op op je harde schijf of usb-stick.
Klik op Add attachment.

Klik op Save Reference.

Let op: Een attachment mag maximaal 20 MB groot zijn. De standaard opslagruimte van een
RefWorks-account is 1 GB.

1.9. VERWIJZINGEN OPNEMEN IN DE TEKST EN EEN LITERATUURLIJST MAKEN
Met Write-N-Cite, een gratis hulpprogramma binnen RefWorks, kun je literatuurverwijzingen

opnemen in de tekst (Word document) en een literatuurlijst maken volgens een standaard
citatiestijl.
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HU-medewerkers die over een laptop van de HU beschikken, dienen deze plug-in uit het Software Center
te downloaden. Ga hiervoor in het Startmenu naar Alle programma’s > Microsoft System Center >
Configuration Manager > Software Center. Zoek op RefWorks, en kies dan de tool Write-n-Cite. Op veel
vaste computers binnen de HU is de Cite plug-in al geinstalleerd.

Als je op je eigen (privé-)computer met Cite wilt werken, dan zul je de tool moeten installeren. - Klik
hiervoor in Refworks op Tools; - Kies de juiste versie van Cite in Microsoft Word. Mac-gebruikers kunnen
ook een Mac-versie van de plug-in downloaden. Eventueel kun je ook de aanwijzingen onder Help >
Write-n-Cite Help volgen.

Write-N-Cite 4 is compatible met Windows Vista, Windows 7, 8 en 10 en met Word 2010, 2013 en 2016.
Windows XP and Word 2007 gebruikers kunnen voorgaande versies van Write-N-Cite 4 of Write-N-Cite 111
gebruiken.

Vanaf Write.N-Cite 4 wordt Refworks als plugin geintegreerd in Word.

Document1 - Word

Home Insert Design Layout References Mailings Review View RefWorks Q Tell me what you w

3 Log In

Citation and Bibliography Extras Settings

Werken met WRITE-N-CITE

Write-N-Cite 4 is als plugin geintegreerd in Word en de toegang vind je dan ook in Word via het tabblad
Refworks. Is deze niet zichtbaar kijk dan in Word onder Bestand — Opties — Invoegtoepassingen

— Beheren COM-invoegtoepassingen — en controleer of bij ‘Write-N-cite’ een vinkje staat. Start Word
opnieuw op.”

Citeren

Zet de cursor op de precieze plaats in een tekst waar je wilt citeren.

Open Write-N-Cite via tabblad “RefWorks” in het menu (lint) in Word.

Kies Log-in en voer je RefWorks user gegevens in.

Selecteer een Output Style (citatie stijl) onder Style in Word.

(Een veel gebruikte Output Style in de Sociale Wetenschappen is APA-6th)
Klik Insert Citation > Insert New. Een pop-up window verschijnt.

£ Insert/Edit Citation >
LiNot in Folder [ X
- Author Year  Title
3 1Ned. Editie
4 1Voorbeeld
4 Behavior
= Beroepsonden
@Bibliografie Edit References
= Co-teaching [] Hide Year Suppress Pages [[] Make Footnote
#i Documents [ Hide Author Override Pages: [ Bibliography only
i Doven Prefix: Suffix:
+ Dubbel :
& Ebseoimport Preview Citation (APA. 6th - American Psychological Association, 6th...
S Esther (No Reference Selected)
@ Excel
2 Gedrag
4 Informatievaar Compose Citation
os New Reference .
“lLast Imported _
 Linkenfolder
Links v =
< > .
[ Override Default Ordering oK cancel
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Write-N-Cite wordt geopend; je ziet de folders met literatuurverwijzingen van je eigen account
verschijnen.

Kies een folder, en de referenties uit die folder worden zichtbaar in de box rechtsboven.

Selecteer één van de referenties (uit de box rechtsboven). Nu verschijnt deze in de onderste box.

Klik op OK.

RefWorks plaatst op de aangegeven plek in je document de gekozen referentie in de aangegeven stijl in
Word.

Herhaal dit voor de andere citaten.

Het is ook mogelijk meerdere literatuurverwijzingen op één plek in te voegen. Klik dan na de eerste
referentie eerst op “+”, rechts naast de onderste box. Daarna kan in de bovenste box een 2e referentie
geselecteerd worden en toegevoegd aan de onderste box.

Ga voor het aanmaken van een Bibliografie met de cursor op de plaats staan waar de bibliografie moet
komen.

Klik op Bibliography Options in Word.

Kies Insert Bibliography.

Sla het document op onder een nieuwe naam.

Als je de literatuurlijst opnieuw wilt aanmaken, kies dan voor “Bibliography Options”, Remove
Bibliography. Daarna Insert Bibliography voor nieuwe lijst.

Een citatie vervangen of verwijderen
Een citatie kan verwijderd worden door de cursor in Word op het citaat te plaatsen (de citatie is

“in blok”) en te dubbelklikken. Het scherm insert/edit citation verschijnt. Klik op de citatie die je wilt
verwijderen en vervolgens op het minnetje rechts

¥ Insert/Edit Citation >
4 Not in Folder  ~ X
! Author Year Title
“a 1Ned. Editie
a1 1Voorbeeld
-1 Behavior
1 Beroepsonder < >
- Bibliografie Edit References
=1 Co-teaching [ Hide Year Suppress Pages ) [ Make Footnote
+a Documents [ ] Hide Author Override Pages: [] Bibliography only
4 Doven Prefix: Suffix:
+/a Dubbel
@ Ebscoimport Preview Citation (APA 6th - American Psychological Association, 6th...
< Esther (van Overveld & Borg, 2015)
4 Excel
i1 Gedrag
& Informatievaar Compose Citation
=Jos van Overveld, Mark, 2015, Brief Emotion Regulation Training Facilitates Arousal C..__ IS
4 Last Imported = 4/
a Linkenfolder
@ Links - I=1
< > [lacal
[] Override Default Ordering OK Cancel

Heb je al een bibliografie aangemaakt dan moet je deze via Bibliography options eerst verwijderen en
later weer aanmaken.

1.10. AANPASSEN VAN EEN OUTPUT STYLE

Via Bibliography > Output Style Manager kun je zien welke citatie stijlen (op alfabet gesorteerd) er in
RefWorks beschikbaar zijn.

Met behulp van de Bibliography > Output Style Editor > New > Kies een Output Style > Edit kun je een
bestaande citatiestijl naar eigen wens aanpassen of een nieuwe citatie stijl genereren. Kies bij voorkeur
een bestaande stijl die op veel punten overeenkomt met de gewenste stijl als uitgangspunt.
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1.11. DELEN
Het delen van referenties kan op diverse manieren:
REFSHARE

Met RefShare kan je je RefWorks databank of bepaalde folders van je RefWorks databank delen
met andere medewerkers of studenten van de HU. Het delen van verwijzingen kan door de link
van de folder(s) via e-mail te versturen naar de persoon die je toegang wil geven tot je folder(s).

Je bepaalt zelf welke toestemmingen (bijv. exporteren, printen, een literatuurlijst maken,
opmerkingen aan verwijzingen toevoegen) de andere gebruikers hebben.
Gebruikers kunnen bij deze vorm van delen niet zelf wijzigen, verwijderen of referenties toevoegen.

Klik om te delen op het tabblad Organise & share folders.

Zoek de map op die je wilt delen, klik op “# en klik vervolgens op Share.
Vul de toestemmingen in en klik op Save. Sluit het venster.

-

Het icoontje is veranderd in =
Klik op dit icoontje en vul de gegevens in bij ‘email this share’. De ontvanger of ontvangers van de mail
kunnen de map inzien en annotaties maken.

GROEPSACCOUNT

Voor het volledig delen van referenties kan het beste een apart groepsaccount worden gemaakt:
Login op Refworks www.refworks.com met instellingsaccount: RWHUtrecht.

Ga naar : Sign up for a new account

Vul je HU emailadres in en verzin een (groeps-) account + paswoord.

Deel deze informatie met de andere gebruikers.

Deze kunnen nu allemaal met dit account werken, 66k tegelijkertijd.

Vanuit dit groepsaccount kunnen referenties ook naar de eigen account geéxporteerd worden.

NB: Tijdens het werken in de gedeelde map moet Refworks onder de eigen, persoonlijke inlogcode NIET
geopend zijn anders gaan alle exporteer-resultaten automatisch daar naar toe.
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